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I n t r o du c t i o n

The technical staff at COMSOL has developed this special COMSOL ECRE Version 
(also referred to throughout this book simply as COMSOL ECRE) exclusively for H. 
Scott Fogler’s book Elements of Chemical Reaction Engineering. As you will see in 
the following pages, COMSOL is an exceptionally powerful tool for performing 
PDE-based modeling and simulations in a broad number of disciplines, but here we 
focus on energy and mass balances. To help you better understand the underlying 
physics and principles, the COMSOL engine runs a number of ready-made models in 
which you can change key parameters and observe the results. Thus, the accompanying 
CD includes the COMSOL computational engine along with six complete models and 
full documentation. These illustrative models combine energy and mass balances in 
both isothermal and non-isothermal conditions using the appropriate application 
modes in COMSOL. 

We have divided the examples into two section. The first section treats radial effects in 
tubular reactors induced by velocity distribution along the radius, and it examines the 
effects of external cooling at a reactor’s outer wall. The second section deals with 
dispersion effects in tubular reactors, and it compares different assumptions for the 
inlet and outlet boundary conditions. It also compares 1-dimensional models with the 
solutions from axisymmetric models. 

More specifically, the models we present are:

• Radial effects in tubular reactors

a Isothermal reactor

b Non-isothermal adiabatic reactor

c Non-isothermal reactor with isothermal cooling jacket

d Non-isothermal reactor with non-isothermal cooling jacket.

• Tubular reactors where the flow includes the effects of dispersion

a 1-dimensional model with Danckwerts boundary conditions

b 1-dimensional model with upstream and downstream sections

The two dispersion models in the second set investigate the Danckwerts boundary 
conditions by comparing them with results obtained from a reactor model that adds 
an inlet and outlet section.
1 :  T H E  C O M S O L  E C R E  V E R S I O N



In all of these models you can change input data—such as rate constants, flow rates, 
diffusivities, and conductivities—and have COMSOL again solve the model. It is also 
possible to visualize results through ready-made expressions or by entering arbitrary 
expressions of the solution variables into COMSOL.

The immediately following section provides a brief introduction to COMSOL and the 
Chemical Engineering Module, which together form the basis for the models just 
listed. If you are already familiar with COMSOL and would prefer to start with the 
exercises immediately, proceed to Chapter 2.
I N T R O D U C T I O N  |  3
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T h e  Ch em i c a l  Eng i n e e r i n g  Modu l e

COMSOL Multiphysics is a modeling package that solves arbitrary systems of partial 
differential equations (PDEs). It allows you to solve these equations in two ways: First, 
in what we refer to as PDE modes, you enter the equations from scratch at the 
keyboard. Second, the software provides a far easier method of solving commonly 
encountered equations whereby you take advantage of ready-made application modes 
targeted at the problem areas the equations describe. For example, the Navier-Stokes 
application mode implements a predefined interface for the modeling of laminar flow 
as described by the Navier-Stokes equations.

The Chemical Engineering Module that comes as an add-on to COMSOL 
Multiphysics delivers a selection of these ready-made application modes for transport 
and reaction processes found in chemical engineering. That module was inspired by 
two classic chemical-engineering texts: Fogler’s Elements of Chemical Reaction 
Engineering and Bird, Stewart, and Lightfoot’s Transport Phenomena.

The Chemical Engineering Module is divided into three application mode menu trees:

• Momentum balances

• Energy balances

• Mass balances

All application modes in COMSOL Multiphysics are equation-based. This means that 
by selecting a ready-made application mode you can easily modify or extend the 
built-in equations. For example, you might elect to enter expressions for source and 
sink terms such as reaction terms.

The following sections offer a short presentation of the application modes in the 
Chemical Engineering Module.

Momentum Balances

The momentum balances application modes encompass the relevant equations for a 
large variety of fluid-flow applications.

Incompressible Navier-Stokes: This application mode defines and solves the 
Navier-Stokes equations where density is a constant, and it includes a range of possible 
boundary conditions. You can easily extend it to include driving forces from other 
phenomena such as electric fields in electrokinetic flow.
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Figure 1-1 shows the flow profile at the junction of several micro-channels, where the 
inlet velocities at the star-like entrance vary in a sinusoidal fashion. You create these 
varying flow profiles by specifying a sinusoidal expression for the inlet pressures and 
introducing a phase shift among the different inlets.

Figure 1-1: Flow velocity field in a star-like micro-channel structure. You enter the 
sinusoidal inlet pressure directly into the graphical user interface’s dialog box for the 
boundary conditions.

Non-Newtonian Flow: This application mode includes two predefined models for 
non-Newtonian fluids—the Carreau model and the power law model, which together 
cover a large group of non-Newtonian fluids. The modeling interface and boundary 
conditions are similar to those for the general Navier-Stokes application mode.

Non-Isothermal Flow: This is also a version of the Navier-Stokes application mode but 
allows for density to include temperature dependencies.

k-ε Turbulence Model: This application mode solves the k-ε model equations for 
turbulent flow. It includes logarithmic wall laws and other boundary conditions 
needed for the simulation of turbulent flow with these equations.

Figure 1-2 illustrates results from a model of a baffled reactor solved with the k-ε 
Turbulence Model application mode. The graph shows the concentration distribution 
T H E  C H E M I C A L  E N G I N E E R I N G  M O D U L E  |  5



6 |  C H A P T E R  
ten seconds after injection at the inlet. The mixing improves with the number of baffles 
that follow the inlet.

Figure 1-2: Concentration distribution in a baffled reactor solved with the k-ε Turbulence 
Model application mode. The extent of mixing increases with the number of baffles.

Darcy’s Law: This application mode deals with porous media flow as described by 
Darcy’s law in combination with the continuity equation.

Brinkman Equations: This extension of Darcy’s law includes the influence of viscosity 
in porous media flow. With it you can treat highly porous structures or combinations 
of open channels and porous structures such as monolithic reactors.

Euler Flow: This application mode is suitable for the modeling of trans-sonic inviscid 
flow. It solves the momentum, mass, and energy balances needed to model 
compressible flow, handling the effects of work done by fluid compression and 
expansion.

Energy Balances

The energy balances application modes account for the transport of energy in fluids 
and solids as well as the generation of heat through chemical reactions.
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Conduction: This application mode defines and solves heat-transfer problems where 
flux is dominated by conduction. It also includes arbitrary reaction terms where you 
can define heat generation from reactions.

Convection and Conduction: This application mode couples fluid flow with energy 
transport. It includes heat transport by conduction, convection, and species diffusion 
in a solution. In the source term it can incorporate arbitrary expressions for heat 
generation such as chemical reactions.

Figure 1-3 shows the temperature field in an enclosure where a heat source sits at its 
bottom and the vertical walls are being cooled. The model combines two application 
modes: Convection and Conduction, and Non-Isothermal Flow. The temperature and 
density variations induce buoyancy-driven flow in the cavity.

Figure 1-3: Temperature field in an enclosure where buoyancy drives the flow. The model 
combines the Conduction and Convection application mode with the Non-Isothermal 
Flow application mode.

Mass Balances

The mass balances application modes deal with a mass balance for each component in 
the system. They can handle arbitrary expressions for reaction kinetics or other source 
or sink terms such as phase transfer.
T H E  C H E M I C A L  E N G I N E E R I N G  M O D U L E  |  7
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Diffusion: This application mode defines and solves Fick’s law for diffusion in 
combination with the continuity equation for each species in a solution. You can also 
include reaction terms.

Diffusion and Convection: This application mode models the transport and reaction of 
species in dilute solutions. The diffusivity can be an arbitrary function of concentration 
or temperature, while the convective term can be easily coupled to fluid flow. 
Alternatively, you can enter independent expressions for convection.

Maxwell-Stefan: This application mode models concentrated solutions where the 
species in solution interact with each other as well as the solvent. It can also include 
reactions.

Figure 1-4 shows the oxygen iso-concentration surfaces in a gas-diffusion cathode for 
a fuel cell. The model couples the Maxwell-Stefan application mode to the 
Navier-Stokes application mode, which describes flow in the channels of the current 
collector.

Figure 1-4: Oxygen concentration in a gas diffusion cathode. The concentration decreases 
from the inlet to the outlet in the serpentine-like structure of the gas channels.

Nernst-Planck: This application mode defines and solves mass balances where the 
model considers the transport of charged species in an electric field in addition to the 
diffusion and convective transport mechanisms. It serves to study electrokinetic 
transport in electrochemical cells and other devices where ions are subjected to electric 
fields.
1 :  T H E  C O M S O L  E C R E  V E R S I O N



L im i t a t i o n s  i n  t h e  COMSOL ECRE 
V e r s i o n

The ECRE Version is a subset of the full version of COMSOL Multiphysics and the 
Chemical Engineering Module. We supply it with the full graphical user interface 
found in the standard COMSOL Multiphysics distribution including all the dialog 
boxes for data input plus the required solvers as defined by Professor Fogler. It also 
features all of the visualization and postprocessing functionality found in COMSOL 
Multiphysics.

Note, however, that the ECRE Version places a number of limitations on capabilities 
found in the standard package:

1 CAD tool. The ECRE Version does not include the drawing and geometry-creation 
functionality included in the full version. The models included in the ECRE Version 
therefore have predefined hard-wired geometries that you cannot modify.

2 Mesh tool. The models we supply in the ECRE Version include a mesh that gives 
good accuracy for a reasonable range of input parameters. You are not able to refine 
or otherwise manipulate the mesh as is possible in the full version.

3 Problem definition. COMSOL Multiphysics allows for the definition of arbitrary 
numbers of equations. The number of equations in the ECRE Version, however, 
cannot be changed. In other words, it is not possible to add or remove equations in 
the models included in this version.

4 File storage. The ECRE Version of COMSOL Multiphysics makes it possible to save 
images and graphs, but it does not allow someone to save a model so it can be 
opened and used at a later date.

5 Model library. COMSOL Multiphysics and the Chemical Engineering Module come 
with a library of solved models from various fields. The ECRE Version does not 
include this model library.
L I M I T A T I O N S  I N  T H E  C O M S O L  E C R E  V E R S I O N  |  9
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Mode l  De s c r i p t i o n ,  Equa t i o n s ,  a nd 
I n pu t  Da t a

This chapter uses the COMSOL ECRE Version to study an elementary, exothermic, 
2nd-order reversible reaction 

in a tubular reactor (liquid phase, laminar flow regime). To keep its temperature down, 
the reactor uses a cooling jacket with a variable coolant temperature. The following 
model setup proceeds in stages, gradually leading to the final configuration. The first 
version of the model deals with an isothermal tubular reactor with composition 
variations in both the radial and axial directions. The second stage extends the model 
to include the energy balance for the reactor. By this addition, the isothermal reactor 
is turned into an adiabatic reactor. The third stage introduces an isothermal cooling 
jacket, and finally the fourth stage models a non-isothermal cooling jacket.

The following section provides a general description for all of the above-mentioned 
models.

Model Description

Figure 2-1: Model geometry for the 2-dimensional rotationally symmetric models.

A B 2C⇔+
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Figure 2-1 illustrates the model geometry. We assume that the variations in angular 
direction around the central axis are negligible, and therefore the model can be 
axi-symmetric.

The system is described by a set of differential equations on a 2D surface that 
represents a cross section of the tubular reactor in the z-r plane. That 2D surface’s 
borders represent the inlet, the outlet, the reactor wall, and the center line. Assuming 
that the diffusivity for the three species is of the same magnitude, you can model the 
reactor using three differential equations; one mass balance for one of the species (as 
noted in the next section, mass balances are not necessary for the other two species), 
one heat balance for the reactor core, and one heat balance for the heating jacket. Due 
to rotational symmetry, the software need only solve these equations for half of the 
domain shown in Figure 2-1.

Model Equations

You describe the mass balances and heat balances in the reactors with partial 
differential equations (PDEs), while one ordinary differential equation (ODE) is 
required for the heat balance in the cooling jacket. The equations are defined as 
follows.

M A S S  B A L A N C E ,  S P E C I E S  A :

where Dp denotes the diffusion coefficient, CA is the concentration of species A, U is 
the flow velocity, R gives the radius of the reactor, and rA is the reaction rate. In this 
model we assume that the species A, B, and C have the same diffusivity, which implies 
that we must solve only one material balance; we know the other species’ 
concentrations through stoichiometry.

B O U N D A R Y  C O N D I T I O N S  F O R  T H E  M A S S  B A L A N C E :

• Inlet (z = 0)

• At the wall (r = R)

Dp
1
r
---

CA∂
r∂

----------- Dp
r2

2

∂

∂ CA Dp
z2

2

∂

∂ CA 2U 1 r
R
----⎝ ⎠

⎛ ⎞ 2
–⎝ ⎠

⎛ ⎞ CA∂
z∂

-----------– rA+ + + 0=

CA r 0,( ) CA0=
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• Center (symmetry) line

The boundary condition selected for the outlet does not set any restrictions except that 
convection dominates transport out of the reactor. Thus this condition keeps the 
outlet boundary open and does not set any restrictions on the concentration. 

• Outlet (z = L)

where L denotes the length of the reactor.

E N E R G Y  B A L A N C E  I N S I D E  T H E  R E A C T O R :

where k denotes the thermal conductivity, T is temperature, ρ is density, Cp equals the 
heat capacity, and ∆HRx is the reaction enthalpy.

B O U N D A R Y  C O N D I T I O N S  F O R  T H E  E N E R G Y  B A L A N C E :

• Inlet (z = 0)

• At the wall (r = R)

where Ta denotes the temperature in the cooling jacket. For an adiabatic reactor, the 
right-hand side of the above equation is zero.

• Center (symmetry) line

CA∂
r∂

----------- R z,( ) 0=

CA∂
r∂

----------- 0 z,( ) 0=

CA∂
z∂

----------- r L,( ) 0=

k1
r
---

T∂
r∂

------- k
r2

2

∂

∂ T k
z2

2

∂

∂ T 2U 1 r
R
----⎝ ⎠

⎛ ⎞ 2
–⎝ ⎠

⎛ ⎞ ρCp
T∂
z∂

-------– rA ∆HRx–( )–+ + 0=

T r 0,( ) T0=

T∂
r∂

-------– R z,( )
Uk

k
------- T Ta–( )=

T∂
r∂

-------– 0 z,( ) 0=
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As for the mass balance, choose the boundary condition at the outlet for the energy 
balance such that it keeps the outlet boundary open. This condition sets only one 
restriction, that the heat transport out of the reactor be convective.

• Outlet (z = L)

E N E R G Y  B A L A N C E  O F  T H E  C O O L A N T  I N  T H E  C O O L I N G  J A C K E T :

Here we assume that only axial temperature variations are present in the cooling jacket. 
This assumption gives a single ODE for the heat balance:

where mc is the mass flow rate of the coolant, CPc represents its heat capacity, and Uk 

gives the heat-transfer coefficient between the reactor and the cooling jacket. You can 

neglect the contribution of heat conduction in the cooling jacket and thus assume 

that heat transport takes place only through convection.

B O U N D A R Y  C O N D I T I O N  F O R  T H E  C O O L I N G  J A C K E T :

You can describe the cooling jacket with a 1D line. Therefore you need only an inlet 
boundary condition.

• Inlet (z = 0)

Model Parameters

We now list the model’s input data. You define them either as constants or as logical 
expressions in COMSOL Multiphysics’s Option menu. In defining each parameter in 
COMSOL Multiphysics, for the constant’s Name use the left-hand side of the equality 
in the following list (in the first entry, for example, Diff), and use the value on the 
right-hand side of the equality (for instance, 1E-9) for the Expression that defines it. 

The constants in the model are:

• Diffusivity of all species, Diff = 1E-9 m2/s

• Activation energy, E = 95238 J/mol

T∂
z∂

-------– r L,( ) 0=

Ta∂
z∂

---------

2πRUk T Ta–( )
mcCPc

------------------------------------------=

Ta 0( ) Ta0=
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• Rate constant, A = 1.1E8 m6/(mol·kg·s)

• Gas constant, R = 8.314 J/mol·K (do not confuse this constant with the geometrical 
extension of the radius)

• Inlet temperature, T0 = 320 K

• Total flow rate, v0 = 5 E-4 m3/s

• Reactant concentrations in the feed, CA0 = CB0 = 500 mol/m3

• Reactor radius, Ra = 0.1 m

• Catalyst density, ρCat, rhoCat = 1500 kg/m3

• Heat of reaction, ∆HRx, dHrx = -83680 J/mol

• Equilibrium constant at 303 degrees K, Keq0 = 1000

• Thermal conductivity of the reaction mixture, ke = 0.559 J/m·s·K

• Average density of the reaction mixture, ρ, rho = 1000 kg/m3

• Heat capacity of the reaction mixture, Cp = 4180 J/kg·K

• Overall heat-transfer coefficient, Uk = 1300 J/m2·s·K

• Inlet temperature of the coolant, Ta0 = 298 K

• Heat capacity of the coolant, CpJ = 4180 J/kg·K

• Coolant flow rate, mJ = 0.01 kg/s

Next, the following section lists the definitions for the expressions this model uses. 
Again, to put each expression in COMSOL Multiphysics form, use the left-hand side 
of the equality (for instance, u0) for the variable’s Name, and use the right-hand side 
of the equality (for instance, v0/(pi*Ra^2)) for its Expression. 

• The superficial flow rate is defined according to the analytical expression

which we define in COMSOL Multiphysics as u0 = v0/(pi*Ra^2).

• The superficial, laminar flow rate

in COMSOL Multiphysics form becomes uz = 2*u0*(1-(r/Ra).^2).

• The conversion of species A is given by

u0
v0

π Ra( )2
-------------------=

uz 2u0 1 r
Ra
--------⎝ ⎠

⎛ ⎞ 2
–⎝ ⎠

⎛ ⎞=
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which in COMSOL Multiphysics form is xA = (cA0-cA)/cA0.

• The concentration of B is according to

which in COMSOL Multiphysics form becomes cB = cB0-cA0*xA.

• The concentration of C is expressed as

which in COMSOL Multiphysics form becomes cC = 2*cA0*xA.

• The rate of reaction takes two forms:

- Before adding the heat balance, the reaction looks like

,

which in COMSOL Multiphysics form is rA = -A*exp(-E/R/
T0)*rhoCat*(cA*cB-cC^2/Keq).

- After you add the energy balance, the reaction expression becomes

,

which in COMSOL Multiphysics form is rA = -A*exp(-E/R/
T)*rhoCat*(cA.*cB-cC^2/Keq).

• The temperature-dependent equilibrium constant is given by the following 
expressions:

- For the isothermal case

xA
CA0 CA–

CA0
------------------------=

CB CB0 CA0 xA–=

Cc 2CA0 xA=

rA A E
RT0
-----------–⎝ ⎠

⎛ ⎞ ρcat cAcB
cc

2

Keq
---------–

⎝ ⎠
⎜ ⎟
⎛ ⎞

exp–=

rA A E
RT
--------–⎝ ⎠

⎛ ⎞ ρcat cAcB
cc

2

Keq
---------–

⎝ ⎠
⎜ ⎟
⎛ ⎞

exp–=

Keq Keq0
∆HRx

R
---------------

1
303
----------

1
T0
------–⎝ ⎠

⎛ ⎞
⎝ ⎠
⎜ ⎟
⎛ ⎞

exp=
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which in COMSOL Multiphysics form is Keq = Keq0*exp(dHrx/R*(1/303-1/T0)).

- After adding the energy balance you obtain

which in COMSOL Multiphysics form is Keq = Keq0*exp(dHrx/R*(1/303-1/T)).

• The heat-production term becomes

which in COMSOL Multiphysics form is Q = -rA*dHrx.

Keq Keq0
∆HRx

R
---------------

1
303
----------

1
T
----–⎝ ⎠

⎛ ⎞
⎝ ⎠
⎛ ⎞exp=

Q r– a∆HRx=
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I s o t h e rma l  R e a c t o r

The first model with radial effects deals only with the material balances in a tubular 
reactor, so you can neglect temperature variations. The model equations can be found 
in the Mass Balance paragraph on page 13.

It is possible to define the model from scratch in the COMSOL Multiphysics Chemical 
Engineering Module. And while the COMSOL ECRE included with Elements of 
Chemical Reaction Engineering does not include the full program’s drawing and 
meshing functionality, it does allow for changes of reaction kinetics and transport 
properties. It also implements all the postprocessing capabilities in the Chemical 
Engineering Module.

The following model setup is targeted at users of COMSOL ECRE, but note that it is 
possible to create the full implementation in the Chemical Engineering Module.

Reviewing the Model in the COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 Insert the COMSOL ECRE CD and select the platform on which you wish to run 
it. The Model Navigator window then appears on the screen. 

2 In this window click the folder 1-Radial Effects in Tubular Flow Reactors, and then 
select the model 1-Isothermal Reactor. Click OK.
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The model opens in Postprocessing mode, and the surface plot shows the 
concentration of species A in the reactor.

Note that the plot does not display the reactor’s dimensions with equal axes in the r- 
and z-directions.

M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

In COMSOL ECRE you can review and change the model equations and input data, 
but you cannot add or remove the so-called application modes that implement the 
model. To review the application modes the model makes use of, do the following:

1 Click the Multiphysics menu. Doing so opens a drop-down list that contains any 
active application modes, in this case the Convection and Diffusion (Mass Balance) 
application mode.

2 Click on the Multiphysics menu again to close the list.

3 Go to the Physics menu and select Subdomain Settings, which opens up the 
corresponding dialog box. Select subdomain 1 in the Subdomain Settings list. This 
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dialog box displays the equation that forms the basis for this application mode, while 
the edit fields show the input data used in the equation. 

The edit fields correspond to the diffusion coefficient, reaction-rate expression, and 
velocity distribution in the reactor—all of which you can freely define. To review and 
change the definition of the input data, follow this procedure:

4 Go to the Options menu and select Constants. The resulting dialog box displays the 
names and definitions of all the constants used in the model. 

You can freely define new constants and rename existing ones. In the dialog box in 
the preceding figure you can identify Diff, which is the diffusion coefficient entered 
in the Diffusion coefficient edit field in the Subdomain Settings dialog box. COMSOL 
ECRE also allows for the definition of expressions.
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5 Go to the Options menu, then to the expandable menu item Expressions, and finally 
select Scalar Expressions.

It is possible to move the Scalar Expressions dialog box in order to also display the 
Constants dialog box. Look closely at the definitions of the scalar expressions and 
recognize that they use constants from the Constants box. Note also that the 
constants and the scalar expressions are defined according to the list of Model 
Parameters in the preceding section. Examine the Subdomain Settings box and note 
that the scalar expression rA in the Reaction rate edit field defines that parameter, 
and the scalar expression uz in the z-velocity edit field defines the corresponding 
velocity component.

6 Click the Cancel button in both the Scalar Expressions, Constants, and Subdomain 

Settings dialog boxes.

Having reviewed the domain equations in the model, you can proceed to the 
boundary conditions.

7 Go to the Physics menu and select Boundary Settings. 
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8 Click on boundary number 1 in the Boundary Selection list. It corresponds to the 
reactor’s central axis.

9 Select boundary number 2 to view the boundary condition at the reactor’s inlet. In 
this case, the constant cA0 defines the inlet concentration in the Boundary Condition 
of type Concentration. You can find the constant’s value in the Constants dialog box 
under the Options menu.

10 Select boundary number 3 to review the outlet boundary condition, which in this 
case is a Convective flux condition. You can use this condition when it is safe to 
assume that the transport of mass perpendicular to the outlet is dominated by 
convection. The boundary condition sets the diffusion term in the mass-flux vector 
in the outlet direction to zero.

11 Select boundary number 4 to review the last condition, which corresponds to the 
reactor’s outer wall and is therefore an insulating boundary for the mass balance.

12 Click the Cancel button to close the Boundary Settings dialog box.

You have now reviewed the input data, domain equations, and boundary conditions. 
To repeat, while you can change all these definitions, you cannot replace or expand the 
Convection Diffusion application mode when running COMSOL ECRE; you need 
the full COMSOL Multiphysics Chemical Engineering Module to extend the model 
to include, for example, additional mass balances.

V I S U A L I Z I N G  T H E  M E S H

Further, while you cannot manipulate the mesh in COMSOL ECRE, it does allow you 
to visualize the mesh by pressing the Mesh Mode button.
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Note in this case that the scales on the r- and z-axes are not equal, which gives a 
distorted view. If desired, you can select equal scale settings in the Axis/Grid Settings 
menu item under the Options menu. In order to return to the original unequal scale 
settings, once again go to the Axes/Grid Settings menu and clear the Axis equal check 
box. Enter -0.1 in the r min edit field, 0.2 in the r max edit field and -0.1 and 1.1 
in the z min and z max edit fields, respectively.

C H E C K I N G  T H E  S O L V E R  S E T T I N G S

COMSOL ECRE allows you to change the equation parameters and reaction kinetics 
and then solve the problem again. The model in this exercise is nonlinear; thus press 
the Solver Parameters and verify that the Stationary nonlinear solver is selected. 

P O S T P R O C E S S I N G

COMSOL ECRE comes with the full set of COMSOL Multiphysics postprocessing 
capabilities. These include surface plots, cross-sectional plots, point plots, as well as 
boundary and subdomain integrations. Now is a good time to review some of the 
software’s plotting and postprocessing capabilities.
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1 Click the Postprocessing Mode button. The default plot shows the concentration of 
species A in the reactor. 

2 Click the Plot Parameters button.

3 Click on the Surface tab.
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4 On the Surface page, enter -rA in the Expression edit field.

5 Click Apply.
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6 To plot the conversion of species A, enter xA in the Expression edit field in the Plot 

Parameters dialog box.

7 Click Apply.

8 In order to define the location of the maximum and minimum conversion, click the 
Max/Min tab.

9 Enter xA in the Expression edit field in the Subdomain max/min data dialog box.

10 Click the Max/min marker check box and click Apply.

11 To visualize the local conversion in selected cross sections along the length of the 
reactor, first go to the Postprocessing menu and select Cross-Section Plot Parameters.

12 Click the Line/Extrusion tab.

13 Enter xA in the Expression edit field.

14 Enter 0 in the r0 edit field and 0.1 in the r1 edit field.

15 Enter 0 in both the z0 and z1 edit fields.

16 Check the Multi parallel lines box, then click the Vector with distances option.
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17 Enter 0 0.5 1 in the Vector with distances edit field to generate three cross-section 
plots at the inlet, in the middle of the reactor, and at the outlet, respectively.

18 Click the Line Settings button. In the dialog box that opens, select the Cycle option 
in the Line color drop-down list; select Solid line in the Line style drop-down list; and 
select None in the Line marker drop-down list.
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19 Finally, to generate the following plot, click OK twice: first in the Line Settings dialog 
box, and then in the Cross-Section Plot Parameters dialog box.

Figure 2-2: Radial conversion profiles at the inlet, outlet and halfway through an 
isothermal reactor.

COMSOL ECRE can also calculate integral expressions of the solution. One such 
entity is the mixing cup outlet concentration, which gives the average concentration 
in the liquid that exits the reactor. For species A, the average concentration is 
defined according to the equation

along the outlet boundary. Start by calculating the integral of CAuz over the outlet 
boundary.

20 Go to the Postprocessing menu and select Boundary Integration.

21 Select boundary 3 in the Boundary selection list.

CA av,

2πrCAuz rd
outlet

∫

2πruz rd
outlet

∫
---------------------------------------------=
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22 Enter 2*pi*r*cA*uz in the Expression edit field.

23 Click Apply.

The value of the integral appears in the status bar at the bottom and reads 
0.115485. You can now calculate the integral of uz.

24 Enter 2*pi*r*uz in the Expression edit field and click Apply.

The value of this integral is 5e-4, which gives an average concentration of 
0.115485/5e-4, which is approximately 231 mole m-3. 

You have now completed a review of the model and are ready to run it with varying 
input parameters.

Questions and Exercises

To answer the following questions you can either use the results in the model just 
described or you can solve it again with a new set of input data.

1 Why is the concentration of species A near the reactor wall lower than the 
concentration near the center?

2 Where in the reactor do you find the minimum and maximum reaction rates?

3 How much is the average conversion? (Hint: See the calculation of the average 
concentration using integrals in the previous section, page 29.)

4 This exercise requires that you change the activation energy for the reaction in the 
model. Do so by going to the Options menu and working with the Constants menu 
item (see item 5 in the section “Model Equations and Input Data” on page 21). We 
have already tabulated the notations in the section “Model Parameters” on page 15. 
After changing the input data, click the Solve button to solve the problem.

It is useful to take the graphs you obtain by changing the activation energy and 
examine them in both two and three dimensions. Once in the Postprocessing mode 
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you can toggle between a two- and three-dimensional plot by clicking the 2D Surface 

Plot button or 3D Surface Plot button. 

a How do the conversion profiles and the average conversion change if you increase 
the activation energy by a factor of 1.5?

b How do these same entities change if you decrease the activation energy by 
multiplying the original value by a factor of 0.95?

The reaction rate is very sensitive to changes in activation energy. Altering the 
activation energy to a lower value increases the reaction rate. A high reaction rate in 
combination with the low flow rate close to the wall results in very large concentration 
gradients. In order to capture an accurate concentration profile, you must apply a dens 
mesh in the inlet area near the wall. This can be done in the full version of the Chemical 
Engineering Module but not in the COMSOL ECRE version.

You have now investigated the isothermal reactor example. Let’s proceed by 
introducing the energy balance in the reactor.
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Ad i a b a t i c  R e a c t o r

This second model with radial effects adds a heat balance to the material balance in the 
previous model. We assume the reactor is adiabatic, which means that its walls are 
insulated and do not exchange heat with the surroundings. The model equations are 
found in the Mass Balance paragraph on page 13, and in the Energy Balance paragraph 
on page 14.

Those working with the COMSOL Multiphysics Chemical Engineering Module could 
generate this model by adding an additional application mode for energy balances to 
the mass balances already included in the previous model. However, COMSOL ECRE 
supplies this model predefined and ready to run. You can freely experiment with 
different input data and still use the full postprocessing capabilities in the Chemical 
Engineering Module.

Reviewing the Model in the COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 If you have already installed COMSOL ECRE, double-click on its icon to open the 
Model Navigator. If not, go to step 1 in the preceding exercise to install the program. 
If you are already using COMSOL Multiphysics, go to the File menu and select New 
to open the Model Navigator. 

2 In the Model Navigator click the folder 1-Radial Effects in Tubular Flow Reactors and 
select the model 2-Adiabatic Reactor. 
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3 Click OK.

The model opens in the Postprocessing mode, and the surface plot shows the 
concentration of species A in the reactor.
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Note that the plot does not display the reactor’s dimensions with equal axes in the r- 
and z-directions.

M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

You can now review and change the model equations.

1 Click the Multiphysics menu. This opens a drop-down list that contains any active 
application modes, in this case both the Convection and Diffusion (Mass Balance) and 
the Convection and Conduction (Energy Balance) application modes. You can select 
among them by clicking on the desired application mode in the drop-down list.

2 Click on the Convection and Conduction application mode.

3 Go to the Physics menu and select Subdomain Settings to open the corresponding 
dialog box. Select subdomain 1 in the Subdomain selection list. This dialog box also 
displays the equation that forms the basis for the Conduction and Convection 
application mode, and the edit fields show the input data used in the energy balance. 

The edit fields correspond to the thermal conductivity, density, heat capacity, and 
velocity distribution in the reactor, all of which you can define freely. To review and 
change the definition of the input data, follow this procedure:
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4 Go to the Options menu and select Constants. The resulting dialog box displays the 
names and definitions of all constants used in the model. 

As already mentioned in the “Isothermal Reactor” example, you can freely define 
new constants and rename existing ones. In this case, focus on ke, the thermal 
conductivity. It is visible in the Thermal conductivity edit field in the Subdomain 

Settings dialog box in the above figure. Let’s look at the definition of the 
expressions.

5 Go to the Options menu, then to the Expressions expandable menu item, and select 
Scalar Expressions.

The scalar expression denoted Q defines the heat generation in the Heat source edit 
field, and uz represents the z-velocity component visible in Subdomain Settings.

6 Click the Cancel button in the Scalar Expressions, Constants, and Subdomain Settings 
dialog boxes.

You have now reviewed the domain equations for the heat balance. You can later 
repeat this process for the mass balance by selecting it in the Multiphysics menu. Next 
proceed to the boundary conditions.

7 Go to the Physics menu and select Boundary Settings. 

8 Click on boundary number 1 in the Boundary Selection list. This boundary 
corresponds to the reactor’s central axis. You can click and drag the box aside to see 
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the selected boundary in the main graphical user interface. The selected boundary 
is marked in red.

9 Select boundary number 2 to view the boundary condition at the reactor inlet. In 
this case, the constant T0 defines the inlet temperature in the Boundary Condition of 
type Temperature. You can find that constant’s value by going to the Options menu 
and opening the Constants dialog box.

10 Select boundary number 3 to review the outlet boundary condition, which in this 
case is a Convective flux condition. You can use this condition when it is safe to 
assume that the transport of heat perpendicular to the outlet is dominated by 
convection. The boundary condition sets the conduction term in the heat-flux 
vector in the outlet direction to zero.

11 Select boundary number 4 to review the final condition, which corresponds to the 
reactor’s outer wall and, because you are modeling an adiabatic reactor, it is 
therefore an insulating boundary.

12 Click the Cancel button to close the Boundary Settings dialog box.

You have now reviewed the input data, domain equations, and boundary conditions 
for the energy balance. You can run the corresponding procedure for the mass balance 
by selecting it in the Multiphysics menu.

V I S U A L I Z I N G  T H E  M E S H

To visualize the mesh click the Mesh Mode button. 
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Note that the scales on the r- and z-axes are not equal, which results in a distorted view. 
If desired, you can select equal scale settings by going to the Options menu and 
checking the Axis equal box in the Axis/Grid Settings menu item. In order to return to 
the original unequal scale settings, once again go to the Axes/Grid Settings menu and 
clear the Axis equal check box. Enter -0.1 in the r min edit field, 0.2 in the r max edit 
field and -0.1 and 1.1 in the z min and z max edit fields, respectively.

C H E C K I N G  T H E  S O L V E R  S E T T I N G S

The model we solve in this exercise is nonlinear. To verify the solver settings, click the 
Solver Parameters button and make certain that the Stationary nonlinear solver is 
selected.

PO S T P R O C E S S I N G

Let’s examine the new results now that we have introduced the energy balance, and 
let’s compare them to those from the “Isothermal Reactor” exercise.
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1 Click the Postprocessing Mode button. The default plot shows the concentration of 
species A in the reactor. 

2 Click the Plot Parameters button.

3 Click the Surface tab.
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4 On the Surface page, go to the Predefined quantities drop-down list and select 
Temperature.

5 Click Apply.

6 To plot the conversion of A, enter xA in the Expression edit field in the Surface page.
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7 Click Apply.

8 To visualize the relation between temperature and conversion, first click the Contour 
tab.

9 Select Temperature (EnergyBalance) in the Predefined quantities drop-down 
list. 
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10 Click the Contour plot check box and click OK.

11 To visualize the local conversion in selected cross sections along the length of the 
reactor, go to the Postprocessing menu and select Cross-Section Plot Parameters.

12 Click the Line/Extrusion tab.

13 Enter xA in the Expression edit field.

14 Enter 0 in the r0 edit field and 0.1 in the r1 edit field.

15 Enter 0 in both the z0 and z1 edit fields.

16 Check the Multi parallel lines box and click the Vector with distances option.
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17 Enter 0 0.5 1 in the Vector with distances edit field to generate three cross-section 
plots at the inlet, in the middle of the reactor, and at the outlet, respectively.

18 Click the Line Settings button. In the dialog box that opens, select the Cycle option 
in the Line color drop-down list; select Solid line in the Line style drop-down list; and 
select None in the Line marker drop-down list.
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19 To generate the following plot, click OK twice: first in the Line Settings dialog box, 
then again in the Cross-Section Plot Parameters dialog box.

Figure 2-3: Radial conversion profiles at the inlet, outlet and halfway through an 
adiabatic reactor.

You can now calculate the mixing cup outlet concentration (see the previous 
example for its definition). Start by calculating the integral of the outlet flux over 
the outlet boundary.

20 Go to the Postprocessing menu and select Boundary Integration.

21 Select boundary 3 in the Boundary selection list.

22 Enter 2*pi*r*cA*uz in the Expression edit field.

23 Click Apply.

The value of the integral appears in the status bar at the bottom of the user interface 
and reads 0.093323. You can now calculate the integral of uz.

24 Enter 2*pi*r*uz in the Expression edit field and click Apply.

The value of this integral is 5e-4, which gives an average concentration of 
0.093323/5e-4, which is approximately 187 mole m-3.
A D I A B A T I C  R E A C T O R  |  43



44 |  C H A P T E R
You have now completed a review of the model and are ready to run it with varying 
input parameters.

Questions and Exercises

To answer the following questions and perform the exercises, you can either use the 
results in the model just presented, or you can solve it again with new input data.

1 How do you explain the difference in outlet conversion between the isothermal and 
non-isothermal adiabatic reactor? (For a clue, examine the temperature plot.)

2 This section deals with the model of an adiabatic reactor. What is special about the 
solution’s surface plot of the temperature? Explain the resulting radial temperature 
distribution. 

3 Increase the thermal conductivity, ke, by a factor of 10 and explain how this affects 
the temperature profiles. At what radial position do you find the highest conversion? 
You can change the thermal conductivity by going to the Options menu and then the 
Constants item. Click the Solve button to solve the problem with the new thermal 
conductivity.
 2 :  R A D I A L  E F F E C T S  I N  TU B U L A R  R E A C T O R S



Non - I s o t h e rma l  R e a c t o r  w i t h  
I s o t h e rma l  C oo l i n g  J a c k e t

The “Adiabatic Reactor” in the preceding exercise is valid under the assumption that 
the reactor cannot interchange heat in the radial direction with the surrounding media. 
This implies that the boundary condition for the energy balance at the radial boundary 
is thermally insulating. Thus, in this next exercise we introduce a cooling jacket around 
the reactor; it has virtually unlimited cooling power because we set its temperature to 
a constant. You can implement this enhancement to the model in the COMSOL 
Multiphysics Chemical Engineering Module by changing the insulating boundary 
condition to a flux boundary condition, where the flux is proportional to the 
temperature difference at the inner wall of the reactor and the cooling jacket. 
COMSOL ECRE already makes this change, and you need only review the new 
constants introduced to express this new boundary condition and the boundary 
condition itself. The model equations are found in the Mass Balance paragraph on page 
13, and in the Energy Balance paragraph on page 14.

Reviewing the Model in the COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 Double click on the COMSOL ECRE icon to open the Model Navigator. If you are 
already using COMSOLCOMSOLcomsol, go to the File menu and select New to 
open the Model Navigator. 
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2 Click the folder 1-Radial Effects in Tubular Flow Reactors and select the model 
3-Non-isothermal Reactor I. Click OK.

The model opens in the Postprocessing mode, and the surface plot illustrates the 
concentration of species A in the reactor.
 2 :  R A D I A L  E F F E C T S  I N  TU B U L A R  R E A C T O R S



Note that the plot does not display the reactor’s dimensions with equal axes in the r- 
and z-directions.

M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

Next it is a good idea to review the model equations and the input data. The model 
equations are almost identical to those for the “Adiabatic Reactor” in the preceding 
exercise. The only differences appear in the list of constants, where this model 
introduces two new constants, and in the radial boundary conditions. Let’s review 
these changes.

1 Click the Multiphysics menu. This opens a drop-down list that contains any active 
application modes, in this case the Convection and Diffusion (Mass Balance) and the 
Convection and Conduction (Energy Balance) application modes.

2 Click on the Convection and Conduction application mode.

3 Go to the Options menu and select the menu item Constants. The resulting dialog 
box displays the name and definition of all the constants this model uses. Scroll 
down to examine the new constants Uk and Ta0. 

You can freely define any additional constants and rename existing ones. For this 
exercise, however, leave them as they are.

4 Click the Cancel button to close the dialog box.

5 Go to the Physics menu and select Boundary Settings. 

6 Click on boundary number 4 in the Boundary Selection list. It corresponds to the 
reactor wall. Here you can see the new Heat flux boundary condition. The heat flux 
is proportional to the difference between the temperature at the reactor’s inner wall 
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(T) and that of the cooling jacket (Ta0). The heat-transfer coefficient, denoted Uk, 
is visible in the Constants item under the Options menu.

7 Click the Cancel button to close the dialog box.

You have now reviewed the changes in input data and boundary conditions for the 
energy balance compared to the “Adiabatic Reactor” example.

V I S U A L I Z I N G  T H E  M E S H

To visualize the mesh, click the Mesh Mode button. 

Note that the scales on the r- and z-axes are not equal, resulting in a distorted view. If 
desired, you can select equal scale settings by going to the Options menu and checking 
the Axis equal box in the Axis/Grid Settings menu. In order to return to the original 
unequal scale settings, once again go to the Axes/Grid Settings menu and clear the Axis 

equal check box. Enter -0.1 in the r min edit field, 0.2 in the r max edit field and -0.1 
and 1.1 in the z min and z max edit fields, respectively.

C H E C K I N G  T H E  S O L V E R  S E T T I N G S

The model in this exercise is nonlinear. Verify that the Stationary nonlinear solver is 
selected for this problem by pressing the Solver Parameters button. 
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PO S T P R O C E S S I N G

Now examine the temperature profile with the new boundary condition.

1 Click the Postprocessing Mode button. The default plot shows the concentration of 
species A in the reactor.

2 Click the Plot Parameters button.

3 Click the Surface tab.

4 Select Temperature in the Predefined quantities drop-down list on the Surface page.
N O N - I S O T H E R M A L  R E A C T O R  W I T H  I S O T H E R M A L  C O O L I N G  J A C K E T  |  49



50 |  C H A P T E R
5 Click OK.

6 To visualize the local temperature in selected cross sections along the length of the 
reactor, go to the Postprocessing menu and select Cross-Section Plot Parameters.

7 Click the Line/Extrusion tab.

8 Enter T in the Expression edit field.

9 Enter 0 in the r0 edit field and 0.1 in the r1 edit field.

10 Enter 0 in both the z0 and z1 edit fields.

11 Check the Multi parallel lines box, then click the Vector with distances option.
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12 Enter 0 0.5 1 in the Vector with distances edit field to generate three cross section 
plots at the inlet, in the middle of the reactor, and at the outlet, respectively.

13 Click the Line Settings button. In the dialog box that opens, select the Cycle option 
in the Line color drop-down list; select Solid line in the Line style drop-down list; and 
select None in the Line marker drop-down list.

14 Finally, to generate the following plot, click OK twice: first in the Line Settings dialog 
box, and then again in the Cross-Section Plot Parameters dialog box.
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.

Figure 2-4: Radial temperature profiles at the inlet, outlet and halfway through a 
non-isothermal reactor with an isothermal cooling jacket.

You have now completed a review of the model and are ready to run it with varying 
input parameters.

Questions and Exercises

Now that we have added a cooling jacket, let’s see how it affects the results. Remember 
that we assumed that the coolant flow is high enough to ensure a constant coolant 
temperature.

1 How does the outlet conversion change compared to the adiabatic reactor model? 
(Hint: See the calculation of the average concentration using integrals in the section 
treating Boundary integration on page 29 and use the same procedure to calculate 
the total conversion.)

2 How does the temperature profile change, and why does it change in this way? 
Where is the maximum temperature now located?
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3 How does the conversion profile change? At which radial position do you find the 
highest conversion? Compare it with that from the adiabatic reactor model in the 
previous exercise.
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Non - I s o t h e rma l  R e a c t o r  w i t h  
Non - I s o t h e rma l  C oo l i n g  J a c k e t

This model is an extension of the previous one, which has an isothermal cooling jacket, 
and the cooling power is more or less unlimited because the cooling media’s 
temperature is constant along the reactor’s length. In contrast, this exercise limits the 
cooling power by introducing a heat balance for the cooling jacket. Thus the cooling 
power decreases as the temperature of the fluid in the jacket increases. The model 
equations are found in the Mass Balance paragraph on page 13, and in the Energy 
Balance paragraph on page 14.

Before starting with this exercise, we can review the model as before with the previous 
models. Then we are ready to change the model parameters to investigate different 
operating conditions for the reactor.

Reviewing the Model in COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 Double click on the COMSOL ECRE icon to open the Model Navigator. If you are 
already using COMSOL Multiphysics, go to the File menu and select New to open 
the Model Navigator. 
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2 In this dialog, click the folder 1-Radial Effects in Tubular Flow Reactors and select the 
model 4-Non-isothermal Reactor II. Click OK.

The model opens in the Postprocessing Mode and the surface plot shows the 
concentration of species A in the reactor.
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Note that the dimensions of the reactor are not displayed with equal axes in the r- and 
z-directions.

M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

The model equations in the reactor are almost identical to those for the “Reactor with 
Isothermal Cooling Jacket” in the preceding exercise. To account for the jacket 
temperature we must introduce two new entries in the list of constants and also change 
the radial boundary condition. In addition, we introduce a new application mode for 
the heat balance in the cooling jacket. Let’s review these changes.

1 Click the Multiphysics menu. Doing so opens a drop-down list that contains any 
active application modes, in this case the Convection and Diffusion (Mass Balance), the 
Convection and Conduction (Energy Balance) and Weak Form, Boundary (wb) 
application modes.

2 Click on the Convection and Conduction application mode.

3 Go to the Options menu and select the menu item Constants. The resulting dialog 
box displays the names and definitions of all the constants the model uses. Scroll 
down to examine the new constants CpJ and mJ. 

You can freely define any additional constants and rename existing ones. For this 
exercise, however, leave them as they are.

4 Click the Cancel button to close the dialog box.

5 Go to the Physics menu and select Boundary Settings. 

6 Click on boundary number 4 in the Boundary Selection list. It corresponds to the 
reactor wall. Here you can see the new Heat flux boundary condition. As in the 
previous example, the heat flux is proportional to the difference between the 
temperature at the reactor’s inner wall (T) and that of the cooling jacket (Ta). 
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However, in this case Ta is not a constant and instead is the dependent variable for 
the temperature in the cooling jacket.

7 Click the Cancel button to close the dialog box.

8 Click the Multiphysics menu and select the Weak Form, Boundary (wb) application 
mode.

9 Go to the Physics menu and select Boundary Settings.

10 Click on the Weak tab and select boundary number 4 in the Boundary Selection list. 
In the Weak Value/Expression edit field you can see the energy balance expression for 
the non-isothermal cooling jacket.

The model uses the Weak Form, Boundary application mode to define a partial 
differential equation in one dimension, along the boundary, to represent the heat 
balance in the cooling jacket. You can identify the expression within the brackets as 
the heat balance of the coolant in the cooling jacket as described in the introduction. 
This heat balance is written in a so-called weak form, which is the form used 
internally in COMSOL Multiphysics. The weak term represents the left-hand side 
of an equation that equals zero. Ta_test is a base function used to define Ta along 
the boundary and is an internal COMSOL Multiphysics syntax.
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11 Click the Cancel button to close the dialog box.

You have now reviewed the changes in input data and boundary conditions for the 
energy balance compared to the “Isothermal Jacket” example.

V I S U A L I Z I N G  T H E  M E S H

To visualize the mesh click the Mesh Mode button. 

Note that the scales on the r- and z- axes are not equal, resulting in a distorted view. If 
desired, you can select equal scale settings by going to the Options menu and checking 
the Axis equal box in the Axis/Grid Settings menu. In order to return to the original 
unequal scale settings, go to the Axes/Grid Settings menu once again and clear the Axis 

equal check box. Enter -0.1 in the r min edit field, 0.2 in the r max edit field, and -0.1 
and 1.1 in the z min and z max edit fields, respectively.

C H E C K I N G  T H E  S O L V E R  S E T T I N G S

The model in this exercise is nonlinear. You can verify that the Stationary nonlinear 
solver is selected for this problem by pressing the Solver Parameters button. 

P O S T P R O C E S S I N G

Let’s look at the temperature profile with the new boundary condition and the 
non-isothermal cooling jacket.

1 Click the Postprocessing Mode button. The default plot shows the concentration of 
species A in the reactor.

2 Click the Plot Parameters button.

3 Click the Surface tab.
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4 Select Temperature in the Predefined quantities drop-down list on the Surface page.

5 Click OK.
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6 To visualize the local temperature in selected cross sections along the length of the 
reactor, go to the Postprocessing menu and select Cross-Section Plot Parameters.

7 Click the Display cross-section in main axes check box to clear it.

8 Click the Line/Extrusion tab.

9 Enter T in the Expression edit field.

10 Enter 0 in the r0 edit field and 0.1 in the r1 edit field.

11 Enter 0 in both the z0 and z1 edit fields.

12 Check the Multi parallel lines box, then click the Vector with distances option.

13 Enter 0 0.5 1 in the Vector with distances edit field to generate three cross-section 
plots at the inlet, in the middle of the reactor, and at the outlet, respectively.

14 Click the Line Settings button. In the resulting dialog box, select the Cycle option in 
the Line color drop-down list; select Solid line in the Line style drop-down list; and 
select None in the Line marker drop-down list.

15 Finally, to generate the following plot, click OK twice: first in the Line Settings dialog 
box, and then again in the Cross-Section Plot Parameters dialog box.
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Figure 2-5: Radial temperature profiles at the inlet, outlet and halfway through a 
non-isothermal reactor with a non-isothermal cooling jacket.

16 To visualize the temperature in the cooling jacket first go to the Domain Plot 

Parameters in the Postprocessing menu.

17 Click the Line/Extrusion tab.

18 Select boundary number 4 in the Boundary Selection list and z from the x-axis data 
drop-down list.
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19 Enter Ta in the Expressions edit field and click OK.

Figure 2-6: The cooling jacket’s temperature profile along the length of the reactor.

You have now completed a review of the model and are ready to run it with varying 
input parameters.

Questions and Exercises

1 How does the temperature profile of the coolant in the cooling jacket change? How 
does it affect the temperature and concentration profiles in the reactor? 

2 Increase the coolant flow rate by a factor of 10. How does the conversion change? 
(Hint: See the calculation of the average concentration using integrals in the section 
treating Boundary integration on page 29 and use the same procedure to calculate 
the total conversion.)

3 What would you do to increase the average outlet conversion?

4 Write two paragraphs describing what you found when you varied the parameters 
for the different types of reactors studied in this chapter. 
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Mode l  De s c r i p t i o n ,  Equa t i o n s ,  a nd 
I n pu t  Da t a

This chapter uses COMSOL ECRE to study the effects of open and closed boundary 
conditions in the modeling of tubular reactors. The following two models also 
exemplify two ways to treat the different types of boundary conditions. The first model 
achieves open or closed boundary conditions using the predefined boundary 
conditions in COMSOL Multiphysics’ Chemical Engineering Module. The second 
model adds an upstream and downstream section to the reactor. It then achieves open 
and closed boundary conditions by varying the Peclet number in these sections. 

These exercises model an arbitrary reaction with undefined reaction order, while a 
dimensionless mass balance, expressed in terms of the Peclet and Damkohler numbers, 
defines the model. The first model studies the effects of reaction order as well as the 
Peclet and Damkohler number. 

Model Description

Figure 3-1: Model geometry for the 1-dimensional models, first using predefined 
COMSOL Multiphysics boundary settings (a), and then using long upstream and 
downstream sections to simulate different boundary conditions (b).

Figure 3-1 depicts the model geometries. The models assume fully developed 
turbulent flow, which reduces the problem to a one-dimensional model, graphically 
represented with a line. The line edges represent the reactor’s inlet and outlet 
(Figure 3-1a) or the inlet and outlet of the upstream and downstream sections 
(Figure 3-1b). 

Reactor

ReactorUpstream Downstream

a)

b)

0 λ

λ0
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Model Equations

The mass balance for the reactor is described by a dimensionless ordinary differential 
equation:

M A S S  B A L A N C E

where Ψ denotes the dimensionless concentration, λ the dimensionless length of the 
reactor, and Per and Da are the dimensionless Peclet and Damkohler numbers, 
respectively. 

We can also use this mass balance when adding sections upstream and downstream to 
the reactor in the second step of the modeling process. However, in these sections we 
set the reaction term–the right-hand side of the mass balance–to zero.

B O U N D A R Y  C O N D I T I O N S

As mentioned in the introduction, the first part of this exercise uses the predefined 
subdomain settings in the Chemical Engineering Module to apply open or closed 
boundary conditions. In the second step, we apply an open boundary condition for the 
upstream section. We then create an open or closed boundary condition for the reactor 
by varying the Peclet number.

The closed-closed boundary conditions for the mass balance are:

• Inlet 

• Outlet 
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At steady state, the open boundary condition for the outlet is identical to the closed 
boundary condition. For the inlet, however, the open boundary condition is the 
following:

• Inlet  .

Model Parameters

Now examine the model’s input data. You define them either as constants or as logical 
expressions in COMSOL Multiphysics’ Option menu. In defining each parameter in 
COMSOL Multiphysics, use the left-hand side of the equality in the following list (for 
example, Per) for the constant’s Name, and use the value on the right-hand side of the 
equality (for instance, 7.5) for the Expression that defines it. 

The constants used in the model are the following:

• Peclet number in the reactor, Per = 7.5

• Damkohler number, Da = 1.29

• Reaction order, n = 1

• Peclet number in the upstream section, Per_up = 1

• Peclet number in the downstream section, Per_down = 1

Only one expressions is defined for this model. 

• The conversion of reactant A is defined according to the analytical expression,

which is defined in COMSOL Multiphysics as: xA = 1-psi.

0λ = 1Ψ =

xA 1 Ψ–=
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D i s p e r s i o n  R e a c t o r  Mode l

The first model uses the predefined boundary settings in COMSOL Multiphysics’ 
Chemical Engineering Module to apply open or closed boundary conditions. Initially, 
the model is set up with closed-closed boundary conditions.

A user of the COMSOL Multiphysics Chemical Engineering Module can define the 
model from scratch. However, the COMSOL ECRE Version included in Elements of 
Chemical Reaction Engineering does not include the draw and mesh functionality in 
COMSOL Multiphysics. Nonetheless, COMSOL ECRE does allow for the change of 
reaction kinetics and transport properties, and it also implements all the postprocessing 
capabilities in the Chemical Engineering Module.

Reviewing the Model in the COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 Insert the COMSOL ECRE CD and select the platform on which you wish to run 
it. You then see the Model Navigator dialog on the screen. 

2 In this dialog box click the folder 2-Flows with Dispersion and Reaction and then 
select the Danckwerts model. Click OK.
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The model opens in the Postprocessing mode and automatically shows the conversion 
profile. 

M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

In COMSOL ECRE you can review and change model equations and input data, but 
you cannot add or remove the application modes that make up the model. To review 
the application modes the model makes use of, do the following:

1 Click the Multiphysics menu. Doing so opens a drop-down list that contains any 
active application modes, in this case the Convection and Diffusion (Mass Balance) 
application mode.

2 Click again on the Multiphysics menu to close the list.

3 Go to the Physics menu and select Subdomain Settings, which opens up the 
corresponding dialog box. Select subdomain 1 in the Subdomain Settings list. The 
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resulting dialog box displays the equation that forms the basis for this application 
mode, while the edit fields show the input data used in the equation. 

The edit fields correspond to the diffusion coefficient, reaction-rate expression, and 
λ-velocity in the reactor—all of which you can freely define. To review and change 
the definition of the input data, follow this procedure:

4 Go to the Options menu and select Constants. The resulting dialog box displays the 
names and definitions of all the constants the model uses. 

You can freely define new constants and rename existing ones. In the dialog box in 
the preceding figure you can identify Per, which represents the inverted diffusion 
coefficient entered in the Diffusion coefficient edit field in the Subdomain Settings 
dialog box. COMSOL ECRE also allows for the definition of expressions.
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5 Go to the Options menu, then to the expandable menu item Expressions, and finally 
select Scalar Expressions.

It is possible to move the Scalar Expressions dialog box in order to also display the 
Constants dialog box. Note that the constants and the scalar expressions are defined 
according to the list of Model Parameters in the preceding section. Examine the 
Subdomain Settings box and note that the constants are used to define the Diffusion 

coefficient parameters.

6 Click the Cancel button both in the Scalar Expressions and Constants dialog boxes. 

7 Click the Init tab in the Subdomain Settings dialog box. Here you could enter an 
initial guess for Ψ that the non-linear solver could use. In this case, because the 
reaction order is set to 1, the problem is linear and you need no initial guess. 
However, if you later want to change the reaction order to higher values, you will 
need to supply an initial guess.

8 Click the Cancel button to exit the Subdomain Settings dialog box.

Having reviewed the domain equations in the model, you can proceed to the 
boundary conditions.

9 Go to the Physics menu and select Boundary Settings. 
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10 Click on boundary number 1 in the Boundary Selection list. It corresponds to the 
reactor’s inlet.

11 Select boundary number 2 to view the boundary condition at the reactor’s outlet.

12 Click the Cancel button to close the Boundary Settings dialog box.

You have now reviewed the input data, domain equations, and boundary conditions. 

V I S U A L I Z I N G  T H E  M E S H

Although you cannot manipulate the mesh in COMSOL ECRE, this version does 
allow you to visualize the mesh by pressing the Mesh Mode button. In this case the mesh 
consists only of points on the line representing the tubular reactor.

C H E C K I N G  T H E  S O L V E R  S E T T I N G S

COMSOL ECRE allows you to change the equation parameters and reaction kinetics 
and then solve the problem again. The model in this first exercise is nonlinear for 
reaction orders higher than 1. In order to solve the model for higher reaction orders, 
click the Solver Parameters button and verify that the Stationary nonlinear solver is 
selected.

PO S T P R O C E S S I N G

COMSOL ECRE comes with the full set of COMSOL Multiphysics postprocessing 
capabilities. These include surface plots, cross-sectional plots, point plots, as well as 
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boundary and subdomain integrations. Now is a good time to review some of the 
software’s plotting and postprocessing capabilities.

1 Click the Postprocessing Mode button. The default plot shows the conversion in the 
reactor. 

2 To plot the concentration, click the Plot Parameters button.

3 Click on the Line tab.
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4 Enter psi in the Expression edit field.

5 Click the Color Expression button and enter psi in the Expression edit field.

6 Click OK in the Line Color Expression frame and again in the Plot Parameters window.
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Questions and Exercises

To answer the following questions and perform the exercises, you can either use the 
results in the model just described or you can solve it again with a new set of input data.

1 Describe how the outlet conversion changes when you alter the following 
parameters:

- Change the Peclet number to 0.1 (to do so, go to the Options menu, select 
Constants, enter 0.1 in the Expression edit field, and finally click Apply). Click the 
Solve button to obtain a new solution.) 

Make sure to reset the Peclet number to the default value (7.5) before moving on 
to the next exercise.

- Change the Damkohler number to 100. Make sure to reset it to the default value 
(1.29) before moving on to the next exercise.

- Change the reaction order to 2. Make sure to reset it to the default value (1) 
before moving on to the next exercise.

2 How does an open or closed boundary condition affected the outlet conversion? 
Change the inlet boundary condition to open with this procedure:

- Go to the Physics menu and select Boundary Settings.

- Select boundary number 1 from the Boundary Selection list.

- Select Concentration from the Boundary condition drop-down list.

- Enter 1 in the Concentration edit field and click OK.

- Click the Solve button to obtain the new solution.

- To switch back to the closed boundary condition, select Flux from the Boundary 

condition drop-down list and enter 1 in the Inward flux edit field. 
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Mode l  W i t h  L ong I n l e t  a nd Ou t l e t  
S e c t i o n s  Add ed t o  t h e  R e a c t o r

In this second model we introduce two new sections to the existing reactor, one part 
upstream and the other downstream relative the reactor. The reaction, however, is still 
limited to the original reactor section; in other words, the Damkohler number for the 
new sections equals zero. The inlet boundary condition for the upstream section and 
the outlet boundary for the downstream section are open. We simulate open or closed 
boundary conditions for the original reactor by altering the Peclet number in the new 
sections.

Those working with the COMSOL Multiphysics Chemical Engineering Module could 
generate this model from scratch by adding the new sections to the geometry in the 
previous model. COMSOL ECRE, however, supplies this model predefined and ready 
to run. You can freely experiment with different input data and still access the full 
postprocessing capabilities in the Chemical Engineering Module.

Reviewing the Model in the COMSOL ECRE Version

O P E N I N G  T H E  M O D E L

1 If you have already installed COMSOL ECRE, double-click on its icon to open the 
Model Navigator. If not, go to step 1 in the preceding exercise to install the program. 
If you are already using COMSOL Multiphysics, go to the File menu and select New 
to open the Model Navigator. 
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2 In the resulting dialog box click the folder 2-Flows with Dispersion and Reaction and 
select the model Three Sections. Click OK. 

The model opens in the Postprocessing mode and automatically shows the conversion 
profile. 
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M O D E L  E Q U A T I O N S  A N D  I N P U T  D A T A

In COMSOL ECRE you can review and change model equations and input data but 
you cannot add or remove the application modes that make up the model. To review 
the application modes this model consists of, do the following:

1 Click the Multiphysics menu. Doing so opens a drop-down list that contains any 
active application modes, in this case the Convection and Diffusion (Mass Balance) 
application mode.

2 Click on the Multiphysics menu again to close the list.

3 Go to the Physics menu and select Subdomain Settings, which opens up the 
corresponding dialog box. You can now see two new subdomains, corresponding to 
the two new sections. This dialog box displays the equation that forms the basis for 
this application mode, while the edit fields show the input data used in the equation. 
Select subdomain 1 in the Subdomain Settings list. 

Subdomain number 1 corresponds to the upstream section. The edit fields 
correspond to the diffusion coefficient, reaction-rate expression, and λ-velocity in 
the reactor—all of which you can freely define. In this case, note that the Reaction 

rate is set to zero. To review and change the definition of the input data, follow this 
procedure:
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4 Go to the Options menu and select Constants. The resulting dialog box displays the 
names and definitions of all the constants the model uses. 

You can freely define new constants and rename existing ones. In the dialog box in 
the preceding figure you can identify Per, which represents the inverted diffusion 
coefficient entered in the Diffusion coefficient edit field in the Subdomain Settings 
dialog box. COMSOL ECRE also allows for the definition of expressions.

5 Go to the Options menu, then to the expandable menu item Expressions, and finally 
select Scalar Expressions.

It is possible to move the Scalar Expressions dialog box to also display the Constants 
dialog box. Note that the constants and the scalar expressions are defined according 
to the list in of Model Parameters in the preceding section. Examine the Subdomain 

Settings box and note that the constants are used to define the Diffusion coefficient 
and Reaction rate parameters.

6 Select subdomain 2 in the Subdomain Selection list to review the reactors subdomain 
settings, which are identical to those in the previous exercise.

7 Select subdomain 3 in the Subdomain Selection list to review the subdomain settings 
for the downstream section. As for subdomain 1, the reaction rate is set to zero.

8 Click the Cancel button in the Scalar Expressions and Constants dialog boxes.
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9 Click the Init tab in the Subdomain Settings dialog box. Here you could enter an 
initial guess for Ψ that the nonlinear solver could use. In this case, because the 
reaction order is set to 1, the problem is linear and no initial guess is needed. 
However, if you later want to change the reaction order to higher values you need 
to define an initial guess. 

10 Different initial values are defined in the various subdomains. View the initial 
guesses by switching among the subdomains in the Subdomain Selection list.

11 Click the Cancel button to exit the Subdomain Settings dialog box.

Having reviewed the model’s domain equations, you can proceed to the boundary 
conditions.

12 Go to the Physics menu and select Boundary Settings. 

13 Click on boundary number 1 in the Boundary Selection list. It corresponds to the 
upstream section’s inlet.

14 Select boundary number 4 to view the boundary condition at the outlet of the 
downstream section.

15 Click the Cancel button to close the Boundary Settings dialog box.

You have now reviewed the input data, domain equations, and boundary conditions. 

V I S U A L I Z I N G  T H E  M E S H

Although you cannot manipulate the mesh in COMSOL ECRE, this version does 
allow you to visualize the mesh by pressing the Mesh Mode button. In this case the mesh 
consists only of points on the line representing the tubular reactor.
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C H E C K I N G  T H E  S O L V E R  S E T T I N G S

COMSOL ECRE allows you to change equation parameters and reaction kinetics and 
solve the problem again. For reaction orders equal to 1 this model is linear. However, 
to solve the model for higher reaction orders you must use a nonlinear solver; thus click 
the Solver Parameters button and verify that the Stationary nonlinear solver is selected.

P O S T P R O C E S S I N G

COMSOL ECRE comes with the full set of COMSOL Multiphysics postprocessing 
capabilities. Now is a good time to review some of the software’s plotting and 
postprocessing functionality.

1 Click the Postprocessing Mode button. The default plot shows the conversion in the 
reactor. 
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2 To plot the dimensionless concentration, click the Plot Parameters button.

3 Click on the Line tab.

4 Enter psi in the Expression edit field.

5 Click the Color Expression button and enter psi in the Expression edit field.
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6 Click OK in the Line Color Expression frame and again in the Plot Parameters window.

Questions and Exercises

To perform the following exercise, solve the model again with a new set of input data.

1 Describe how the outlet conversion changes when you alter the Peclet number in 
the new sections to simulate open-open and closed-closed boundary conditions. 
Small values of the Peclet number indicate negligible dispersion and simulate a 
closed boundary condition. Values of the Peclet number in the new sections 
comparable to the those in the reactor section indicate substantial dispersion and 
simulate an open condition.

Go to the Options menu, then to Constants, then change the upstream and 
downstream Peclet numbers. Click the Solve button to obtain a new solution. 
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A adiabatic 32

application mode

Brinkman Equations 6

Conduction 7

Convection and Conduction 7

Darcy’s law 6

Diffusion 8

Diffusion and Convection 8

Euler Flow 6

Incompressible Navier-Stokes 4

k-e Turbulence Model 5

Maxwell-Stefan 8

Nernst-Planck 8

Non-Isothermal Flow 5

Non-Newtonian flow 5

B boundary condition 13, 14, 15

closed 64, 65, 75

open 64, 66, 75

boundary settings 22, 35, 47, 56, 70, 79

Brinkman Equations 6

C closed boundary condition 64, 65, 75

Conduction 7

contour plot 41

Convection and Conduction 7

conversion 16, 66

cross-section plot 27, 41, 50, 60

D Damkohler number 64, 75

Darcy’s law 6

Diffusion 8

Diffusion and Convection 8

E energy balance 6, 14, 15

equilibrium constant 17

Euler Flow 6

F flow rate

laminar 16

superficial 16

H heat-production term 18

I Incompressible Navier-Stokes 4

initial guess 70, 79

K k-e Turbulence Model 5

L laminar flow rate 16

M mass balance 7, 13, 65

max/min marker 27

Maxwell-Stefan 8

mixing cup outlet concentration 29

momentum balance 4

N Nernst-Planck 8

Non-Isothermal Flow 5

Non-Newtonian flow 5

O open boundary condition 64, 66, 75

P Peclet number 64, 75

R rate of reaction 17

S subdomain settings 20, 34, 68, 77

superficial flow rate 16
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